
Vendor: SAP

Exam Code: C_BOCR_08

Exam Name: SAP Certified Application Associate – 
Crystal Reports 2008

Version: Demo



QUESTION: 1 
Which method can you use to insert field objects into a Crystal report? 

A. Select the Field option from the Insert menu. 
B. Right-click the area where you want the field object to appear, then select Insert Field 
Object from the Context menu. 
C. Click the field name, drag it to the desired position and release the mouse button to 
insert. 
D. Click the Field button on the Formatting toolbar. 

Answer: C 

QUESTION: 2 
You need a report that shows all customers and allows the report reader to view either a 
report listing all days in the month to date or to view only the customers with daily sales 
greater  than $5000. You decide to use report alerts to accomplish this. Which formula 
properly sets the alert condition? 

A. Sum ({Orders.Order Amount}, {Orders.Order Date}, "daily") > 5000 
B. Sum ({Orders.Order Date}, {Orders.Order Amount}, "daily") > 5000} 
C.  IF  Sum  ({Orders.Order  Amount},  {Orders.Order  Date},  "daily")  >  5000  THEN 
crCondition = "Enabled" 
D.  IF  Sum  ({Orders.Order  Amount},  {Orders.Order  Date},  "daily")  >  5000  THEN 
AlertMessage = "Enabled" 

Answer: A 

QUESTION: 3 
Which two formulas can you use to determine whether the content of a string is a number? 
(Choose two.) 

A. IsNumber({Orders.Customer ID}) 
B. NumberText({Orders.Customer  ID}) 
C. IsNumeric({Orders.Customer ID}) 
D. NumericText({Orders.Customer  ID}) 

Answer: C, D 

QUESTION: 4 



In Crystal Reports you select multiple report objects at the same time. Which two menu 
options become available when you right-click one of the selected objects? (Choose two.) 

A. Move 
B. Insert 
C. Delete 
D. Copy 
E. Cut 

Answer: D, E 

QUESTION: 5 
You want to see a list of formulas containing references to a specific field. Which method 
can you use? 

A. Browse Field 
B. Repository Explorer 
C. Formula Field Search 
D. Global Formula Search 

Answer: D 

QUESTION: 6 
You copy a report from BusinessObjects  Enterprise and modify the report. Which two 
methods can you use to save changes back to BusinessObjects Enterprise? (Choose two.) 

A. Save the report using the Report Explorer. 
B. From the Main menu, select Save and choose Enterprise. 
C. From the Main menu, select Save and choose Web Folders. 
D. Save the report using the Repository Explorer. 

Answer: B, D 

QUESTION: 7 
Which two methods can you use to change the appearance of an object that you add to a 
Crystal report? (Choose two.) 

A. Hold down CTRL + Spacebar and click on the object. 
B. Right-click the object and use the Format Editor. 



C. Select the object and use the Formatting toolbar. 
D. Drag-and-drop the object to the Formatting toolbar. 

Answer: B, C 

QUESTION: 8 
What  two  configuration  options  are  valid  for  long  Lists  of  Values  (LOV)  in  Crystal 
Reports 2008? (Choose two.) 

A. UI Batch Size 
B. Database Timeout 
C. Maximum LOV Size 
D. Maximum Rowset Records 

Answer: A, C 

QUESTION: 9 
Which two statements describe how optional prompts behave in Crystal Reports 2008? 
(Choose two.) 

A. If no value is entered in the prompt, all values are returned. 
B. If no value is entered in the prompt, no values are returned. 
C. If the parent prompt is optional, the child prompt must be optional. 
D. If the child prompt is optional, the parent prompt must be optional. 

Answer: A, C 

QUESTION: 10 
Which formula uses the correct syntax to assign a variable a value in Crystal syntax? 

A. Numbervar x; x = 5; 
B. Dim x as Number x = 5 
C. Dim x as Number x := 5 
D. Numbervar x; x := 5; 

Answer: D  

QUESTION:11 



You create a new Crystal report and want to add a Top N sort, but the Group Sort Expert is 
inactive. How can you activate the Group Sort Expert? 

A. Insert a group name field. 
B. Insert a summary field. 
C. Insert a running total field. 
D. Insert a formula field. 

Answer: B 

QUESTION: 12 
You must create a static array in a Crystal report to be used for numeric calculations in 
other formulas. How can you do this? 

A. Global NumberVar Array newArray := Array (1, 2, 3, 4, 5); 
B. Global NumberVar Array newArray := MakeArray (1, 2, 3, 4, 5); 
C. Global NumberVar Array newArray := CreateArray (1, 2, 3, 4, 5); 
D. Global NumberVar Array newArray := DefineArray (1, 2, 3, 4, 5); 

Answer: B 

QUESTION: 13 
When should you use parameters? 

A. When creating conditional Top N reports. 
B. When identifying the data source location. 
C. When identifying trends in data. 
D. When creating dynamic groups. 

Answer: D 

QUESTION: 14 
Which special field can you use to display the date a report was last changed? 

A. Modification Date 
B. Modification LastDate 
C. Modification LastUpdate 
D. Modification Time 



Answer: A 

QUESTION: 15 
You are creating a Crystal report to show just the Top N countries in an international sales 
report based on total sales for the previous quarter.  The value of N is dynamic.Which 
method must you use to achieve the required result? 

A.  Using  the  Group  Select  Expert,  create  a parameter  to  set  the  value  of  N.  Add  a 
conditional formula to view just the Top N countries. 
B. After creating a parameter to set the value of N, reference that parameter within the 
Group Sort Expert. Refresh the report setting the value of N in the parameter to show just 
the Top N countries. 
C. Using the Group Sort Expert, create a parameter  to set the value of N. Refresh the 
report setting the value of N in the parameter to show just the Top N countries. 
D. After creating a parameter to set the value of N, refresh the report to view just those 
countries with a grand total that is greater than N. 

Answer: B 

QUESTION: 16 
Which three lines of code will generate an error? (Choose three.) 

A. Local Number x := 1; 
B. Local NumberVal x := 1; 
C. Local NumberVar x := 1; 
D. Local NumberValue x := 1; 

Answer: A, B, D 

QUESTION: 17 
You want to use the Workbench feature to manage multiple reports and publish them to 
BusinessObjects  Enterprise  as  object  packages.  Your  manager  is  concerned  that  any 
Crystal user could access and make changes to the reports located on the Workbench. How 
can you address your manager's concerns? 

A. Encrypt object packages. 
B. Password protect object packages. 
C.  Assign  appropriate  permissions  to  object  packages  that  are  published  to 
BusinessObjects Enterprise. 



D. Track changes on object packages using the Dependency Checker. 

Answer: C 

QUESTION: 18 
You design a Crystal summary report that is grouped by Region then by Customer Name. 
The Details section is hidden. The report includes a bar chart that displays total orders by 
Customer Name for each Region group. Which procedure will display the chart beside the 
sections that show Customer Name and Total Sales? 

A. Place the chart in the Group  Header #1 section and format the section to Underlay 
Following Sections. 
B. Place the chart in the Details section and format the section to suppress if duplicated. 
C. Place the chart in the Group  Footer #2 section and  format  the section  to Underlay 
Following Sections. 
D. Place the chart in the Group Footer #2 section and format the section to suppress if 
duplicated. 

Answer: A 

QUESTION: 19 
What is the reason you cannot insert a Group layout chart in the Page Header section? 

A. You do not have access to the database. 
B. The Page Header section is suppressed. 
C. A Group layout chart cannot be placed in the Page Header section. 
D. You have not saved the report with data. 

Answer: C 

QUESTION: 20 
After you select a BusinessObjects Universe to use as the data source for a Crystal report, 
you create a query using the BusinessObjects Query Panel. What must you do to access the 
underlying data source? 

A. Create a local cache of the data source. 
B. Create a connection to the data source. 
C. Create a local ODBC resource for the data source. 
D. Log in to BusinessObjects Enterprise. 



Answer: D 

QUESTION: 21 
Which  three If-Then-Else  control structure formulas  in Crystal  syntax will generate  an 
error? (Choose three.) 

A. If {Orders.Order Amount} < 100 Then"Under $100"ElseIs {Orders.Order Amount} in 
100 to 200 Then "Between $100 and $200" 
B. If {Orders.order Amount} < 1000 Then "Low" Else "High" 
C. If {Orders.Order Amount} < 100 Then formula = "Under $100" ElseIf {Orders.Order 
Amount} in 100 to 200 Then formula = "Between $100 and $200" EndIf 
D. If {Orders.Order Amount} < 200 ThenUnder $200 ElseIf {Orders.Order Amount} in 
200 to 300 Then Between $200 and $300 

Answer: A, C, D 

QUESTION: 22 
Which two methods can you use to insert field objects into a Crystal report? (Choose two.) 

A. Right-click the area where you want the field object to appear, then select Insert Field 
Object from the Context menu. 
B. Click the field name, drag it to the desired position and release the mouse button to 
insert. 
C. Open the Section Expert and click the Insert button. 
D. Click the field name and click the Insert to Report icon at the top of the Field Explorer. 
Drag the field to the desired position and left-click to insert. 

Answer: B, D 

QUESTION: 23 
You are designing a Crystal report that summarizes customer orders by country, then by 
state, then by city and by customer ID. You want the report to print each country on a new 
page. Thefirst page should display a bar chart showing Total Sales by Country group in the 
Report Header and as much of the first country as can be displayed. The last page should 
show the summary for the last country and the grand total for the entire report. Which step 
can you perform in the Section Expert to achieve the design goal? 

A. Set New Page After on for Group Footer #1 



B.  Conditionally  format  the  New  Page  After  property for  Group  Footer  #1 using the 
formula "not onlastrecord" 
C. Format  the New  Page After property for Group  Header  #1 using  the formula  "not 
onlastrecord" 
D. Set New Page After on for the Report Header section 

Answer: B 

QUESTION: 24 
You want to create a formula using the Formula Workshop. You begin by right-clicking 
Formula Fields in the Field Explorer and then click the New button. What happens after 
you click the New button? 

A. You must select the type of formula and click OK. 
B. The Formula Workshop opens with the Formula Editor inactive. 
C. You must enter a formula name and click OK. 
D. The Formula Workshop opens with the Formula Editor active. 

Answer: C 

QUESTION: 25 
Which three options are provided for web pagination? (Choose three.) 

A. Navigation controls 
B. Page breaking controls 
C. Conditional Page Margin controls 
D. Portrait versus Landscape controls 

Answer: B, C, D 

QUESTION: 26 
What are three Crystal Reports 2008 viewer features? (Choose three.) 

A. Docked/Stationary Toolbar 
B. Export to Microsoft PowerPoint 
C. Java DHTML Viewer Exporting 
D. Independent Group Tree Scrolling 



Answer: A, C, D 

QUESTION: 27 
How must you register multiple XML export formats in Crystal Reports 2008? 

A. Configure XML export formats using the Define XML dialog. 
B. Configure XML export formats using the Manage XML dialog. 
C. Add XML export formats using the Manage XML Exporting Formats dialog. 
D. Add XML export formats using the Define XML Exporting Formats dialog. 

Answer: C 

QUESTION: 28 
You have created a report with a parameter but the parameter value is not always required. 
Which method should you use? 

A. Set Editable to True 
B. Set Null Values to True 
C. Set Custom Values to True 
D. Set Optional Prompt to True 

Answer: D 

QUESTION: 29 
Which two reasons explain why the Group Sort Expert is disabled when you attempt to 
create a Top N report? (Choose two.) 

A. You are in Design view. 
B. The data was not refreshed. 
C. You are in a Drill Down view. 
D. The report is missing a summary value. 

Answer: C, D 

QUESTION: 30 
You make changes to the record selection criteria in a Crystal report. In which two 
circumstances should you choose the Refresh Data option rather than the Use Saved Data 
option? (Choose two.) 



A. When up-to-the-minute, current information must be displayed on the report. 
B. When adding one or more selection criteria. 
C. When it is important to avoid time delays caused by network traffic during database 
server connects. 
D. When removing one or more existing selection criteria. 

Answer: A, D 

QUESTION: 31 
Which Crystal Reports feature can you use to limit the number of records included in a 
report? 

A. SQL Expression 
B. Formula Workshop 
C. Preview Sample 
D. Record Selection Formula 

Answer: D 

QUESTION: 32 
The database structure is changed to include a Products table. Which tool would you use to 
add the Products table to the Customer Sales report? 

A. Field Explorer 
B. Select Expert 
C. Report Explorer 
D. Database Expert 

Answer: D 

QUESTION: 33 
You create a new Crystal report and group the report by the customer name and then by 
country. The tables in your database have a one-to-many linking relationship. Because of 
the linking relationship, field values from the primary table are repeated for each new field 
value causingdouble  counting  in the lookup  table. Which two methods can you use to 
create accurate summaries? (Choose two.) 

A. Use Dynamic Summarized Fields Expert. 
B. Use Running Total Expert. 
C. Create conditional grouping formulas. 



D. Create manual running totals. 

Answer: B, D 

QUESTION: 34 
What can Crystal Reports developers use to add application-specific toolbars to the Report 
Designer? 

A. Add-Ins 
B. WorkBench 
C. Report Options 
D. Insert Toolbars 

Answer: A 

QUESTION: 35 
Which method could you use to create a new formula in your report? 

A. Right-click on the Formula Fields category in the Report Explorer and choose the New 
option. 
B. Select the New Formula option from the Insert menu. 
C. Select the New Formula option from the Format menu. 
D. Right-click on the Formula Fields category in the Field Explorer and choose the New 
option. 

Answer: D 

QUESTION: 36 
Which method can you use to display a field when specific criteria are met? 

A. Conditionally format the field in the Field Editor. 
B. Conditionally format the field in the Section Expert. 
C. Conditionally format the field in the Select Expert. 
D. Conditionally format the field in the Format Editor. 

Answer: D 

QUESTION: 37 



How can you modify a report to display the word "low" when the field value is 0 - 4, and 
the word "high" when the field value is 5 - 9? 

A. Create a new conditional suppression formula. 
B. Use the Select Expert. 
C. Create a new conditional display string formula. 
D. Use the Highlighting Expert. 

Answer: C 

QUESTION: 38 
Which two options can you select in the Group Expert? (Choose two.) 

A. Bottom N 
B. In specified order 
C. In original order 
D. Top N 

Answer: B, C 

QUESTION: 39 
Which two formulas will determine the number of elements in an array? (Choose two.) 

A. Global NumberVar Array simpleArray; Count(simpleArray); 
B. Global NumberVar Array simpleArray; Value(simpleArray); 
C. Global NumberVar Array simpleArray; UBound(simpleArray); 
D. Global NumberVar Array simpleArray; Number(simpleArray); 

Answer: A, C 

QUESTION: 40 
Which formula returns the sum of Last Year's Sales by Country? 

A. sum(Customer.Last Year's Sales,{Customer.Country}) 
B. sum({Customer.Last Year's Sales}{Customer.Country}) 
C. sum({Customer.Last Year's Sales},{Customer.Country}) 
D. sum({Customer.Country},{Customer.Last Year's Sales}) 

Answer: C 



QUESTION: 41 
What type of data does Crystal Reports 2008 store when exporting to XML? 

A. Static 
B. Ad-hoc 
C. Dynamic 
D. On-Demand 

Answer: A 

QUESTION: 42 
You must change the logo used in your Crystal reports on a regular basis. Your company 
owns  a  license  for  Crystal  Reports  but  does  not  own  a  license  for  BusinessObjects 
Enterprise. Which option can you use to easily change the logo? 

A. Add to the Repository 
B. Dynamic Graphic Location 
C. Dynamic Prompt Parameter 
D. Convert Picture Object 

Answer: B 

QUESTION: 43 
Which option will you choose from the Group Select Expert to display the countries that 
generate the least orders? 

A. Top N 
B. Descending 
C. No Sort 
D. Bottom N 

Answer: D 

QUESTION: 44 
You are designing a Crystal report that contains a Gantt chart designed to assist in project 
management. Which fields must you select to create this chart? 



A. One "For Each Record" field and one date field under "Show values" 
B. Two "For Each Record" fields and one date field under "Show values" 
C. Two "For Each Record" fields and two date fields under "Show values" 
D. One "For Each Record" field and two date fields under "Show values" 

Answer: D 

QUESTION: 45 
You want to add a drillable Xcelsius chart to a report. Which method must you use? 

A. Send the Crystal report fields to the Xcelsius chart via formula fields. 
B. Map the Crystal report fields to the Xcelsius chart in the Formula Editor. 
C. Send the Crystal report fields to the Xcelsius chart via shared variables. 
D. Map the Crystal report fields to the Xcelsius chart in the Flash Data Binding Expert. 

Answer: D 

QUESTION: 46 
What is the reason you are unable to edit a report that was created against an ODBC data 
source? 

A. The report field is not dynamic. 
B. You did not authenticate to the data source. 
C. The ODBC data source is too large for the report. 
D. You set the report to read-only. 

Answer: D 

QUESTION: 47 
You  want  to  use  conditional  formatting  to  link  a  dynamic  image  object, 
corporate_logo.jpg,  to a Crystal report. Which format should you use for referencing the 
location of the graphic image? 

A. [C:\Images\corporate_logo.jpg] 
B. "C:\Images\corporate_logo.jpg" 
C. C:\Images\corporate_logo.jpg 
D. {C:\Images\corporate_logo.jpg} 



Answer: B 

QUESTION: 48 
You create a report showing annual sales grouped by customer name but want to display 
results for customers in North America only. Which two techniques can you use to achieve 
this result? (Choose two.) 

A. A drill-down group 
B. The record selection formula 
C. A cross-tab 
D. The group selection formula 

Answer: B, D 

QUESTION: 49 
Which three units of measure can you use to define the page size? (Choose three.) 

A. Inch 
B. Twip 
C. Pixel 
D. Centimeter 

Answer: A, C, D 

QUESTION: 50 
What is the default file version when you save a report to crystalreports.com? 

A. Crystal Reports 9 
B. Crystal Reports XI 
C. Crystal Reports 4.5 
D. Crystal Reports 2008 

Answer: D 

QUESTION: 51 



You have made a decision to use an existing report as the corporate template. You have 
beenasked to create a sales report. Which two report objects will the template apply to the 
new report? 

A. Detail Charts 
B. Group Charts 
C. Cross-tabs 
D. Summary Fields 

Answer: B, D 

QUESTION: 52 
Which two export options can you use to display the correct Page N of M values in an 
exported file? (Choose two.) 

A. Report Definition 
B. Rich Text Format 
C. Acrobat Format (PDF) 
D. XML 

Answer: B, C 

QUESTION: 53 
What would cause Crystal Reports to refresh the report data? 

A. Deleting an existing field 
B. Adding a previously unused field to the report 
C. Repositioning an existing field 
D. Creating a calculation with two existing fields 

Answer: B 

QUESTION: 54 
Crystal Reports developers can extend the functionality of Crystal Reports by using add- 
ins in the Report Designer. With the use of add-ins, what do report developers now have 
the abilit y to do?(Choose two.) 

A. Add application specific toolbars 



B. Launch other applications 
C. Dynamically set page size 
D. Set database connections based on a parameter 

Answer: A, B 

QUESTION: 55 
In which two sections of a report can you insert a Cross-Tab object? (Choose two.) 

A. Group Header 
B. Page Header 
C. Report Header 
D. Details 

Answer: A, C 

QUESTION: 56 
Which two methods can you use to create a new cross-tab in your report? (Choose two.) 

A. Select the Cross-Tab Expert from the Format menu. 
B. Select the Cross-Tab option from the Insert toolbar. 
C. Select the Cross-Tab option from the Insert menu. 
D. Select the Cross-Tab option from the Formatting toolbar. 

Answer: B, C 

QUESTION: 57 
Which data source does Crystal Reports 2008 automatically install? 

A. HTML 
B. JDBC 
C. Salesforce.com 
D. crystalreports.com 

Answer: C 

QUESTION: 58 



A motorcycle  manufacturer  contracts  you  to produce  a complex  inventory  report.  The 
Production  Manager  informs  you  that  the  seventh  character  in  each  motorcycle's  12- 
character serial number (SN) represents the type of engine used. The report must be sorted 
by engine type. Which formula will meet the requirement? 

A. {Stock.SN} (7) 
B. {Stock.SN} [7] 
C. Mid [{Stock.SN}, 7] 
D. Mid ({Stock.SN}, 7) 

Answer: B 

QUESTION: 59 
Which two statements are true regarding barcodes? (Choose two.) 

A. BLOB fields can be converted to barcode format. 
B. UPC Barcode support is standard in Crystal Reports 2008. 
C. Converting a field to a barcode was not available prior to Crystal Reports 2008. 
D. If "####" displays when a field is converted to a barcode, the display field must be 
widened. 

Answer: B, D 

QUESTION: 60 
Which two top-level data source folders can you choose if you want to create a new report 
using the Standard Report Creation Wizard? (Choose two.) 

A. Universes 
B. ODBC 
C. Create New Connection 
D. Repository 

Answer: C, D 

QUESTION: 61 
Which two formulas will return a string of 10 blank spaces? (Choose two.) 

A. InsertSpace(10) 



B. Space(10) 
C. ReplicateString(" ", 10) 
D. RepeatString(" ", 10) 

Answer: B, C 

QUESTION: 62 
Which feature of Crystal Reports formulas must you use to perform a prescribed  set of 
steps without specifying each step? 

A. Functions 
B. Operators 
C. Procedures 
D. Variables 

Answer: A 

QUESTION: 63 
You design a report in Crystal Reports using three different groups. You notice that you 
insertedthe  first and second  groups backwards: first by City, then by State and then by 
Customer.  Thecorrect  sequence  is  State,  then  City  and  then  Customer.  Which  two 
procedures can you use to correct this situation? (Choose two.) 

A. Delete only the City group. Use the Insert Group icon to recreate the Cit y group and 
move it between the State and Customer groups. 
B. Open the Group Expert and use the black arrows in the upper required corner to reorder 
the groups as required. 
C. Delete the first two groups and recreate them in the correct order. 
D. In the Design view, click the Group Header #2 caption on the left side and drag it on 
top of  the Group  Header  #1  caption.  Release  your  mouse  button and  the  groups  will 
reverse sequence. 

Answer: B, D 

QUESTION: 64 
You need to modify an existing calculated member in a Cross-Tab. Which three formulas 
can you edit? (Choose three.) 

A. Header formula 
B. Insertion formula 



C. Row value formula 
D. Column value formula 

Answer: A, B, D 

QUESTION: 65 
You are developing a Crystal report for a vehicle leasing company. All vehicle information 
is stored in an array, with each member of the array representing a different vehicle type. 
The vehicle model is represented b y the third position of the alphanumeric vehicle stock 
number. Which formula will return the vehicle model from the stock number? 

A. Local stringvar array saModels := ["car","truck","van","SUV"]; 
saModels[Tonumber({Invty.Stk#}[3])]; 
B.  Local  stringvar  array  saModels  ["car","truck","van","SUV"]; 
saModels[Tonumber({Invty.Stk#}[2])]; 
C.  Local  stringvar  array  saModels  :=  ["car","truck","van","SUV"]; 
saModels[Tonumber({Invty.Stk#}[2])]; 
D.  Local  stringvar  saModels  :=  ["car","truck","van","SUV"]; 
saModels[Tonumber({Invty.Stk#}[3])]; 

Answer: A 

QUESTION: 66 
You want to connect to your Salesforce.com  database  for reporting.  Which server will 
authenticate you? 

A. Salesforce.com 
B. crystalreports.com 
C. Windows Active Directory 
D. BusinessObjects Enterprise XI 

Answer: A 

QUESTION: 67 
You create a Crystal report that requires the company logo to appear on all pages after the 
title  page.  You  want  to  use  conditional  suppression.  Which  formula  will produce  the 
correct result? 

A. PageNumber >= 2 



B. PageNumber < 2 
C. PageNumber = 1 
D. PageNumber := 1 

Answer: C 

QUESTION: 68 
Which formula can you use in a record selection to include all dates from the first day of 
the month to the date the report is refreshed? 

A. {Orders.Order Date} in CurrentMonth 
B. {Orders.Order Date} in MonthToDate 
C. {Orders.Order Date} in MonthToToday 
D. {Orders.Order Date} in CurrentDate 

Answer: B 

QUESTION: 69 
Which formula calculates the difference in weeks between two date values? 

A. DateDiff ("yyyy", #10/7/1999#, #10/31/1999#) 
B. DateDiff ("w", #10/7/1999#, #10/31/1999#) 
C. DateDiff ("ww", #10/7/1999#, #10/31/1999#) 
D. DateDiff ("weeks", #10/7/1999#, #10/31/1999#) 

Answer: B 

QUESTION: 70 
Each employee in your organization has a unique employee ID. The fifth character of the 
employee  ID  represents  the  department  code.  Which  control  structure  in  the  Crystal 
Reports Formula Editor will enable you to use the employee ID to group the employees by 
department? 

A. Subscript 
B. Select Case 
C. Else 
D. Count 

Answer: B 



QUESTION: 71 
You need to create a report using a stored procedure. The required procedure is missing 
from the Database Expert. Which configuration change in the Database tab of the Options 
dialog box could cause this? 

A. Disabling the Verify Stored Procedures On First Refresh option 
B. Disabling the Stored Procedures option 
C. Enabling the Synonyms option 
D. Enabling the System Tables option 

Answer: B 

QUESTION: 72 
Which special field can you use to display the total number of pages in a report on the first 
page of the report? 

A. Page Count 
B. Total M Count 
C. Page Number 
D. Total Page Count 

Answer: D 

QUESTION: 73 
In which pass do shared variables get processed? 

A. Pre-pass 2 
B. Pass 1 
C. Pass 3 
D. Pass 2 
E. Pre-pass 3 

Answer: D 

QUESTION: 74 
What must be enabled to use the Custom Zoom Factor in Crystal Reports 2008? 



A. Active X 
B. CMC rights 
C. .NET framework 
D. Latest Java update 

Answer: A 

QUESTION: 75 
When creating a parameter in Crystal Reports, when is the edit mask option available? 

A. For a parameter that uses a dynamic prompt and requires a string value. 
B. For any type of parameter that uses a static prompt. 
C. For any type of parameter that uses a dynamic prompt. 
D. For a parameter that uses a static prompt and requires a string value. 

Answer: D 

QUESTION: 76 
A report  requires a pie chart that enables users to drill down on each slice to see the 
underlyingdetails.  Which type of chart layout should you select on the Data tab of the 
Chart Expert in order to support the report's requirements? 

A. Group 
B. OLAP 
C. Cross-Tab 
D. Detail 

Answer: A 

QUESTION: 77 
Which operator can you use in Crystal syntax to comment out a piece of code? 

A. Comment (') 
B. Comment (//) 
C. Comment (Rem) 
D. Comment (#) 

Answer: B 



QUESTION: 78 
Which formula can you use in a record selection to include all dates 30 days from the date 
the report is refreshed? 

A. {Orders.Order Date} in Prev30Days 
B. {Orders.Order Date} in NextMonth 
C. {Orders.Order Date} in NextPeriod 
D. {Orders.Order Date} in Next30Days 

Answer: D 

QUESTION: 79 
How can you change a field's position? 

A. Select the Size and Position option in the Report menu. 
B. Select the Location option in the Format menu. 
C. Right-click the field and choose the Size and Position option. 
D. Right-click the field and choose the Location option. 

Answer: C 

QUESTION: 80 
You need to create a formula that extracts the area code from each customer's telephone 
number and displays the region based on the area code. Phone numbers are stored in a text 
field in the form 555-555-5555. Which formula will meet the stated requirements? 

A.  Local  stringVar  sCode  := {Customer.Phone}  [1 to 3]; IF sCode  in ["604",  "250"] 
THEN "BC" ELSE IF sCode in ["415", "714","310","661"] THEN "CA"; 
B. Shared  stringVar  sCode := {Customer.Phone}  [1 to 3]; IF aCode in ["604",  "250"] 
THEN "BC" ELSE IF aCode in ["415", "714","310","661"] THEN "CA"; 
C. stringVar sCode := {Customer.Phone} [1 to 3]; IF sCode in ["604", "250"] THEN "BC" 
ELSE IF sCode in ["415", "714","310","661"] THEN "CA"; 
D. Global numberVar sCode := {Customer.Phone}  [1 to 3]; IF sCode in ["604", "250"] 
THEN "BC" ELSE IF sCode in ["415", "714","310","661"] THEN "CA"; 

Answer: A 

QUESTION: 81 



You create a new Crystal report and add an alert. After refreshing the report the alert is 
triggered. New data that meets the alert condition is added to the database, but the alert is 
not triggered again. Why is the alert NOT triggered? 

A. The AlertMessage flag is set to "False." 
B. Once an alert is triggered, it is not evaluated again until the report is refreshed. 
C. The alert condition must be refreshed after the alert is triggered. 
D. Alerts are only triggered once per report. 

Answer: B 

QUESTION: 82 
Which three methods can you use to access the Global Formula Search? (Choose three.) 

A. In the Preview Pane, right click on the field. 
B. In the Formula Editor, right click on the field. 
C. In the Preview Pane, select the field and press Alt-D. 
D. In the Formula Editor, select the field and press Alt-D. 

Answer: A, B, D 

QUESTION: 83 
You are designing a Crystal report that contains a chart. Your chart must contain one "On 
change of" value and one "Show" value. Which three chart types can you use? (Choose 
three.) 

A. Stock 
B. Pie 
C. Funnel 
D. Radar 

Answer: B, C, D 

QUESTION: 84 
Which three options can you use to export a Crystal report to a file type that maintains 
conditional formatting? (Choose three.) 

A. Rich Text Format 



B. MS Excel 97-2003 
C. Acrobat Format (PDF) 
D. XML 

Answer: A, B, C 

QUESTION: 85 
You are using a parameter to highlight sections in a Crystal Reports 2008 report. What will 
happen if you run the report with a different parameter value? 

A. A database refresh will occur. 
B. The report will produce an error. 
C. The report refreshes from saved data. 
D. A database logon prompt will appear. 

Answer: C 

QUESTION: 86 
You create a new Crystal report using a dynamic cascading parameter. You want to use all 
available values in the parameter prompt without selecting each value individually.  How 
can you achieve the required result? 

A. Create an "All values" item using a shared variable then reference this item in the 
record selection formula. 
B. Create an "All values" item in a command object then reference this item in the record 
selection formula. 
C. Create an "All values" item using the All command  then reference  this item in the 
record selection formula. 
D. Create an "All values" item using an argument then reference this item in the record 
selection formula. 

Answer: B 

QUESTION: 87 
You  specify the  "read-only"  option on the Common tab of the Section Expert.  Which 
action can a user perform on objects in that section when editing the report? 

A. Move 
B. Copy 



C. Format 
D. Delete 

Answer: B 

QUESTION: 88 
You create a new dynamic cascading parameter using an existing prompt group in a report. 
You receive an "Unable to save the parameter" error message trying to save the parameter. 
Why does this happen? 

A. The Prompt Group Text is not conditionally formatted. 
B. The Value names within the dynamic cascading parameter are duplicated elsewhere in 
the report. 
C. The Description field is empty. 
D. The prompt group already has parameters bound to each level. 

Answer: D 

QUESTION: 89 
You  design  a  Summary  report  with the  Suppress  option  selected  instead  of  the  Hide 
option.  Which  two  types  of  information  will  be  displayed  when  you  double-click  a 
summary figure on the report?(Choose two.) 

A. Detail Header information 
B. Group Header information 
C. Detail Footer information 
D. Group Footer information 

Answer: B, D 

QUESTION: 90 
Numbers are stored in a string field in your database. To perform numeric calculations on 
this field, the data must be converted to a number. Which formula will correctly convert 
the data? 

A. If IsNumber ({Table.Field}) Then ConvertNumber ({Table.Field}) Else 0 
B. If IsNumber ({Table.Field}) Then ToNumber ({Table.Field}) Else 0 
C. If NumericText ({Table.Field}) Then ToNumber ({Table.Field}) Else 0 
D. If NumericText ({Table.Field}) Then ConvertNumber ({Table.Field}) Else 0 



Answer: C 

QUESTION: 91 
Which two statements are true regarding hyperlinking in Crystal Reports 2008? (Choose 
two.) 

A. The source and target report parameter lists must be identical. 
B. The hyperlinking GUI will automatically pick up parameters in the target report. 
C. Only Boolean parameters are allowed when linking a source report to a target report. 
D. The report developer can define a constant as the input to a target report parameter. 

Answer: B, D 

QUESTION: 92 
You want to see a list of formulas containing references to a specific field. Which three 
methods can you use? (Choose three.) 

A. In the Formula Editor, right click on the field and choose Find in Formulas. 
B. In the Preview Pane, right click on the field and choose Find in Formulas. 
C. In the Formula Editor, select the field and press Alt-D to open Global Formula Search. 
D. In the Preview Pane, select the field and press Alt-D to open Global Formula Search. 

Answer: A, B, C 

QUESTION: 93 
You configure a database connection which you use regularly for your reports. In which 
folder should you save the connection to make it easy to access? 

A. Repository 
B. Current Connections 
C. History 
D. Favorites 

Answer: D 

QUESTION: 94 



Which two sections are displayed when the Crystal Reports Design window first opens? 
(Choose two.) 

A. Page Footer 
B. Formula Footer 
C. Group Footer 
D. Report Footer 

Answer: A, D 

QUESTION: 95 
The Sales department has a report listing the two sales channels, Direct and Indirect. There 
is a grand total for all sales at the end of the report. There is however also a requirement 
for a grandtotal for each channel. Which method should you use to provide the total for 
each channel? 

A. Create 2 running totals, evaluating on the relevant channel, and place them in the report 
header. 
B. Create 2 running totals, evaluating on the relevant channel, and place them in the group 
header. 
C. Create 2 running totals, evaluating on the relevant channel, and place them in the report 
footer. 
D. Create 2 running totals, evaluating on the relevant channel, and place them in the group 
footer. 

Answer: C 

QUESTION: 96 
You have legacy data in a proprietary database. Which two ways can you connect to the 
data for reporting? (Choose two.) 

A. ODBC driver 
B. HTML driver 
C. Web Services 
D. Crystal Reports Gateway 

Answer: A, C 

QUESTION: 97 



You want to save a report that you have not run with data. There are no subreports. Which 
procedure should you use to save the report data? 

A. From the Preview tab, select Save As and save the report. 
B. From the Design tab, select Save As and save the report. 
C. From the Design tab, select Save Data with Report and save the report. 
D. From the Preview tab, select Save Data with Report and save the report. 

Answer: D 

QUESTION: 98 
You want to use a Cross-Tab to see the difference in Canada's sales versus USA's sales. 
Which method should you use in Crystal Reports 2008 if the field does not exist? 

A. Use a calculated member. 
B. Use a parameter field within the Cross-Tab. 
C. Insert a Sum summary for Canada's sales. 
D. Insert a custom group as a Cross-Tab member. 

Answer: A 

QUESTION: 99 
Your report includes a dynamic parameter named "Where" that uses a cascading list of 
values from Country to Region to City. You create discrete value parameters for all three 
fields.  Using  Los  Angeles  as  an  example,  you  want  to  display  the  report  title  as 
"Customers  in Los  Angeles,  CA,  USA".  Which  text  object  will  display  the  report  as 
required? 

A. Customers in {?Where ?City}, {?Where ?Region}, {?Where ?Country} 
B. Customers in {?Where ?City} + - + {?Where ?Region} + , + {?Where ?Country} 
C. Customers in {?Where ?City}, {?Where ?Country}, {?Where ?Region} 
D. Customers in {?Where ?Country}, {?Where ?Region}, {?Where ?City} 

Answer: A 

QUESTION: 100 
Which lines of code use the correct syntax to assign a variable a value in Basic syntax? 



A. Numbervar x; x = 5;, 
B. Dim x as Number x := 5 
C. Numbervar x; x := 5; 
D. Dim x as Number x = 5 

Answer: D 

QUESTION: 101 
In Crystal Reports you select multiple report objects at the same time. Which three menu 
options become available when you right-click one of the selected objects?(Choose three.) 

A. Format Objects 
B. Align 
C. Size 
D. Delete 
E. Move 

Answer: A, B, C 

QUESTION: 102 
You create a new Crystal report with a summary value. You must select only the Bottom 
N groups,  removing  groups  that  do  not fit the  criteria.  Some  groups  may  have  equal 
summarized  values.  How can you accomplish the required  result using the Group  Sort 
Expert? 

A. Select the Bottom Percentage sort option, deselect the Include Others option and select 
the Include ties option. 
B. Select  the Bottom  N sort option,  deselect  the Include  Others  option and  select  the 
Include ties option. 
C. Select the Bottom Percentage sort option, select the Include Others option and select the 
Include ties option. 
D. Select the Bottom N sort option, select the Include Others option and select the Include 
ties option. 

Answer: B 

QUESTION: 103 
Which two types of objects can you apply dynamic field sorting to? (Choose two.) 



A. Text Field 
B. Field Heading 
C. Formula Field 
D. Database Field 
E. Parameter Field 

Answer: A, B 

QUESTION: 104 
You must summarize the sales amounts for all customers with less than $1000 per sale. 
How would you evaluate this in the Running Total Expert? 

A. For each record 
B. On change of field 
C. Use a formula 
D. On change of group 

Answer: C 

QUESTION: 105 
You want to use a report's data in another application. The application requires the data in 
a custom XML format. Which two steps must you perform? (Choose two.) 

A. Import the XSLT. 
B. Export the XSLT. 
C. Import the report using XML. 
D. Export the report to XML format. 

Answer: A, D 

QUESTION: 106 
Which  three  BusinessObjects  Enterprise  XI  tasks  support  XML  exporting  in  Crystal 
Reports 2008? (Choose three.) 

A. Viewing B. 
Auditing C. 
Publishing 
D. Scheduling 



Answer: A, C, D 

QUESTION: 107 
Which statement is true regarding the Object Linking Wizard? 

A. Enables report designers to define an URL. 
B. Enables report designers to define how a subreport is linked to the main report. 
C. Enables report designers to specify how an Xcelsius chart is linked in a report. 
D. Enables report designers to specify the order in which subreports should be processed. 

Answer: A 

QUESTION: 108 
Which three procedures will create a second Report Header section named "Report Header 
b." (Choose three.) 

A. Working in the Design window, right-click the grey area containing the section name 
Report Header and click Insert Line in the shortcut menu to create Report Header b. 
B. Working in the Design window, right-click the grey area containing the section name 
Report  Header  and  click  Insert  Section  Below  in  the  shortcut  menu  to  create  Report 
Header b. 
C. On the Common tab of the Section Expert, highlight the Report Header and click the 
Insert button at the top of the window. Click OK to create Report Header b. 
D. Working in the Design window, point to the left boundary of the Report Header until 
the section splitting cursor appears and drag it down to split the section into Report Header 
a and Report Header b. 

Answer: B, C, D 

QUESTION: 109 
You create the following array in a new Crystal report: ["dog", "cat", 1.25, True] Why do 
you get an error when you save the formula? 

A. The Boolean value must be the first array element. 
B. The array elements are not in alphabetical order. 
C. You cannot summarize the elements in an array. 
D. You cannot have more than one data type in an array. 

Answer: D 



QUESTION: 110 
How do you point an existing report to a new universe in Crystal Reports 2008? 

A. Create a new report. 
B. Update linking in report. 
C. Recreate the universe query. 
D. Reset the data source location to the new universe. 

Answer: D 

QUESTION: 111 
How would you customize a report to enable users to define the data returned? 

A. Create groups specific to the users' needs. 
B. Use a parameter in the record selection formula. 
C. Use variables to conditionally suppress data. 
D. Create an argument and use it in a formula. 

Answer: B 

QUESTION: 112 
Which two statements are true regarding the Object Linking Wizard in Crystal Reports 
2008? (Choose two.) 

A. Object Linking Wizard can use Report Parts. 
B. BusinessObjects Enterprise XI R3 must be installed. 
C. BusinessObjects Enterprise XI R2 must be installed. 
D. Object Linking Wizard contains all the OpenDocument options. 

Answer: B, D 

QUESTION: 113 
Which two actions will refresh report data? (Choose two.) 

A. Repositioning a print-time formula field 
B. Inserting a new summary 



C. Adding a field not currently used 
D. Changing the report's data parameters 

Answer: C, D 

QUESTION: 114 
You are running your report by date and must view three fiscal quarters. Which method 
should you use when the report is based on a command object? 

A. Use a multi-value parameter in a subreport. 
B. Use many single-value parameters in a subreport. 
C. Use a multi-value parameter in the command object. 
D. Use many single-value parameters in the command object. 

Answer: C 

QUESTION: 115 
Which two methods can you use to convert NULL values to the database default? (Choose 
two.) 

A. Create a formula to convert all NULL values to database default. 
B.  Create  a statement  in the  record  selection  to convert  all NULL  values  to database 
default. 
C. Select the Convert Database NULL Values to Default checkbox in the Report Options 
menu. 
D. Select the Convert Database NULL Values to Default checkbox on the Reporting tab of 
the Options menu. 

Answer: C, D 

QUESTION: 116 
The Sales Department needs a Crystal report that shows total sales by day for the month 
and allows the report reader to view either a report listing all days in the month to date or a 
shorter report showing just the days when sales exceeded a bonus target of $10000. You 
decide  to  use  report  alerts  to  accomplish  this.  Which  formula  properly  sets  the  alert 
condition? 

A. Sum ({Orders.Order Date}, {Orders.Order Amount}, "daily") > 10000 



B.  IF  Sum  ({Orders.Order  Amount},  {Orders.Order  Date},  "daily")  >  10000  THEN 
crCondition ="Enabled" 
C.  IF  Sum  ({Orders.Order  Amount},  {Orders.Order  Date},  "daily")  >  10000  THEN 
AlertMessage ="Enabled" 
D. Sum ({Orders.Order Amount}, {Orders.Order Date}, "daily") > 10000 

Answer: D 

QUESTION: 117 
You create an If-Then-Else  formula  for a Crystal report. When  you close the Formula 
Editor, you receive the error message  "A string is required  here." Which two formulas 
could return such an error? (Choose two.) 

A.  IF  {Customer.Country}  >  "Canada"  THEN  {Orders.Order  Amount}  ELSE 
{Orders.Order Amount} * 1.20 + "CDN." 
B. IF {Orders.Order Amount} > 5000 THEN "High Order" ELSE {Orders.Order Amount} 
> 3000 then "OK" 
C. IF {Orders.Order Amount} > 5000 THEN "High Order" ELSE 0 
D. IF {Orders.Order Amount} > 5000 THEN "High Order" ELSE {Orders.Order Date} 

Answer: C, D 

QUESTION: 118 
Which function could you use to change a DateTime value from one time zone to another? 

A. ChangeDateTime 
B. ModifyDateTime 
C. ShiftDateTime 
D. MoveDateTime 

Answer: C 

QUESTION: 119 
You use the following conditional formatting formula to display a background  color of 
yellow when the condition is met: IF {Table.Field Name} > 5000 THEN Yellow You want 
the background color to be white when the condition is not met. Which two lines can you 
add to the conditional formatting formula to achieve the requirement? (Choose two.) 



A. ELSE NoColor 
B. ELSE Transparent 
C. ELSE CurrentFieldValue 
D. ELSE White 

Answer: A, D 

QUESTION: 120 
Which method can you use to resize a section when working in the Design window of 
Crystal Reports? 

A. Move the section boundary. 
B. Insert a Subsection Line. 
C. Drag and drop the corner of the section window. 
D. Select Zoom In/Out from the View menu. 

Answer: A 

QUESTION: 121 
How can you enable users to sort data in a report when they do not have a connection to 
the database? 

A. Use sort controls 
B. Create a custom sort 
C. Create a sort formula 
D. Use a parameterized sort 

Answer: A 

QUESTION: 122 
Which method can you use to split results of a report of customer names into two groups, 
A-M and N-Z? 

A. Create an original order group. 
B. Use the Record Sort expert. 
C. Use the Group Sort expert. 
D. Create a specified order group. 

Answer: D 



QUESTION: 123 
Which  three font attributes  can be adjusted  in the Format  Editor dialog box? (Choose 
three.) 

A. Size 
B. Type 
C. Background Color 
D. Color 

Answer: A, B, D 

QUESTION: 124 
You create a formula in Crystal Reports using a parameter named"MyParam"'.  How will 
the parameter appear in the body of the formula? 

A. {@MyParam\} 
B. {#MyParam\} 
C. {MyParam\} 
D. {%MyParam\} 

Answer: C 

QUESTION: 125 
You  want  to  display  total  sales  amounts  greater  than  $5000  in  purple  with  a  silver 
background and bold text. Which two features should you use to meet the requirements? 
(Choose two.) 

A. Conditional formatting 
B. The Section Expert 
C. The Format Painter 
D. The Highlighting Expert 

Answer: A, D 

QUESTION: 126 
How can you position multiple fields on the same baseline in your report? 
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